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Introduction

Simulink Product Description

Simulation and Model-Based Design

1-2

Simulink is a block diagram environment for multidomain simulation and Model-Based Design. It
supports system-level design, simulation, automatic code generation, and continuous test and
verification of embedded systems. Simulink provides a graphical editor, customizable block libraries,
and solvers for modeling and simulating dynamic systems. It is integrated with MATLAB®, enabling
you to incorporate MATLAB algorithms into models and export simulation results to MATLAB for
further analysis.

Key Features

Graphical editor for building and managing hierarchical block diagrams

Libraries of predefined blocks for modeling continuous-time and discrete-time systems
Simulation engine with fixed-step and variable-step ODE solvers

Scopes and data displays for viewing simulation results

Project and data management tools for managing model files and data

Model analysis tools for refining model architecture and increasing simulation speed
MATLAB Function block for importing MATLAB algorithms into models

Legacy Code Tool for importing C and C++ code into models



Model-Based Design with Simulink

Model-Based Design with Simulink

Modeling is a way to create a virtual representation of a real-world system. You can simulate this
virtual representation under a wide range of conditions to see how it behaves.

Modeling and simulation are valuable for testing conditions that are difficult to reproduce with
hardware prototypes alone. This is especially true in the early phase of the design process when
hardware is not yet available. Iterating between modeling and simulation can improve the quality of
the system design early, by reducing the number of errors found later in the design process.

You can automatically generate code from a model and, when software and hardware implementation
requirements are included, create test benches for system verification. Code generation saves time
and prevents the introduction of manually coded errors.

In Model-Based Design, a system model is at the center of the workflow. Model-Based Design enables
fast and cost-effective development of dynamic systems, including control systems, signal processing
systems, and communications systems.

Model-Based Design allows you to:

* Use a common design environment across project teams

* Link designs directly to requirements

» Identify and correct errors continuously by integrating testing with design
* Refine algorithms through multidomain simulation

* Automatically generate embedded software code and documentation

» Develop and reuse test suites

1-3



1 Introduction

Complete

Requirements
Integration and Test

System-Level
Design

System
Integration and Test

Subsystem
Design

Subsystem

Integration and Test

Subsystem
Implementation

Example Model-Based Design Workflow in Simulink

To get started with a Model-Based Design task, consider this workflow.
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Model-Based Design with Simulink

Determine
Modeling Goals

-,

Determine Test System
Components Model

Model System

Integrate
Layout Compenents
Model Test system
Components components

Analyze Model

Design New Test Designed
Components + Components

The workflow in this tutorial focuses on fundamental Simulink tasks as they relate to Model-Based
Design.

» “System Definition and Layout” on page 1-7 — Identify modeling goals, determine components,
model system layout.

* “Model and Validate a System” on page 1-13 — Model and test components, integrate
components, test system.

* “Design a System in Simulink” on page 1-23 — Design and test new components.
The first two tasks in this workflow model an existing system and establish the context for designing
a component. The next step in this workflow would be to implement the new component. You can use

rapid prototyping and embedded code generation products, such as Simulink Real-Time™ and
Embedded Coder®, to generate code and use the design with a real, physical system.

See Also

Related Examples

. “System Definition and Layout” on page 1-7
. “Model and Validate a System” on page 1-13
. “Design a System in Simulink” on page 1-23
. “Organize Large Modeling Projects”
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External Websites
. Simulink Overview
. Model-Based Design with MATLAB and Simulink
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https://www.mathworks.com/videos/simulink-overview-61216.html
https://www.mathworks.com/videos/model-based-design-with-matlab-and-simulink-69040.html

System Definition and Layout

System Definition and Layout

In this section...

“Determine Modeling Objectives” on page 1-7
“Identify System Components and Interfaces” on page 1-8

The top-level system layout of a Simulink model is a common context that many engineering teams
can use and is the basis for many tasks in the Model-Based Design paradigm: analysis, design, test,
and implementation. You define a system at the top level by identifying the structure and individual
components. You then organize your model in a hierarchical manner that corresponds to the
components. Then you define interfaces for each component and the connections between
components.

The featured model in this tutorial is a flat robot that can move or rotate with the help of two wheels,
similar to a home vacuuming robot. This model assumes that the robot moves in one of two ways:

* Linear — Both wheels turn in the same direction with the same speed and the robot moves

linearly.
* Rotational — The wheels turn in opposite directions with the same speed and the robot rotates in
place.
o
Left »7 Direction
wheel

of motion

Right
wheel

Each type of motion starts from a resting state, that is, both rotational and linear speeds are zero.
With these assumptions, the linear and rotational motion components can be modeled separately.

Determine Modeling Objectives

Before designing a model, consider your goals and requirements. The goals dictate both the structure
and the level of detail for the model. If the goal is simply to figure out how fast the robot can go,
modeling just for linear motion is sufficient. If the goal is to design a set of inputs for the device to
follow a given path, then the rotational component is involved. If obstacle avoidance is a goal, then
the system needs a sensor. This tutorial builds a model with the goal of designing sensor parameters
so that the robot stops in time when it detects an obstacle in its path. To achieve this goal, the model
must:

1-7
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* Determine how quickly the robot stops when the motors stop

* Provide a series of commands for linear and rotational motion so that the robot can move in a two-
dimensional space

The first modeling objective enables you to analyze the motion so you can design the sensor. The
second objective enables you to test your design.

Identify System Components and Interfaces

Once you understand your modeling requirements, you can begin to identify the components of the
system. Identifying individual components and their relationships within a top-level structure help
build a potentially complex model systematically. You perform these steps outside Simulink before you
begin building your model.

This task involves answering these questions:

* What are the structural and functional components of the system? When a layout reflects the
physical and functional structure, it helps you to understand, build, communicate, and test the
system. This becomes more important when parts of the system are to be implemented in different
stages in the design process.

* What are the inputs and outputs for each component? Draw a picture showing the connections
between components. This picture helps you to visualize signal flow within the model, identify the
source and sink of each signal, and determine if all necessary components exist.

* What level of detail is necessary? Include major system parameters in your diagram. Creating a
picture of the system can help you identify and model the parts that are essential to the behaviors
you want to observe. Each component and parameter that contributes to the modeling goal must
have a representation in the model, but there is a tradeoff between complexity and readability.
Modeling can be an iterative process. You can start with a high-level model with few details and
then gradually increase complexity where required.

It is often beneficial to consider the following:

»  What parts of the system need testing?
* What is the test data and success criteria?
* Which outputs are necessary for analysis and design tasks?

Identify Robot Motion Components

The system in this tutorial defines a robot that moves with two electric wheels in two dimensions. It
includes:

* Linear motion characteristics

* Rotational motion characteristics

* Transformations to determine the location of the system in two dimensions

* A sensor to measure the distance of the robot from an obstacle

Left Wheel

Force
Inputs

Rotation Coordinate
Computation Transformation

Sensor

1-8
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System Definition and Layout

The model for this system includes two identical wheels, input forces applied to the wheels, rotational
dynamics, coordinate transformation, and a sensor. The model uses a Subsystem to represent each
component:
1 Open a new Simulink model. See “Open New Model” on page 3-3.

Open the Library Browser. See “Open Simulink Library Browser” on page 3-5.

Add Subsystem blocks. Drag five Subsystem blocks from the Ports & Subsystems library to the
new model.

4  Click a subsystem. In the Format tab, click the Auto name drop-down. Clear the Hide
Automatic Block Names check box.

Auto

AE': Image Gmtem © This block follows "Hide Automatic Block Names' model setfing

BLOCK L4 on
O .
Always show name of this block

[] | Aute ¥

a Off
" Always hide name of this block

Hide Automatic Block Names

5 Arrange and rename the Subsystem blocks as shown. To change block names, double-click the
block name and edit the text.

LW

In1 Quti [

LW

In1 Quti [

Left Wheael Coordinate Transform

qint Quti [

Inputs

qint Quti [ qint Quti [

Right Whesl Rotation

Define Interfaces Between Components

Identify input and output connections between subsystems. Input and output values change
dynamically during a simulation. Lines connecting blocks represent data transfer. This table shows
the inputs and outputs for each component.

Block Input Output Related Information

Inputs None Force to right wheel Not applicable

Force to left wheel

Right wheel Force to right wheel Right wheel velocity Directional, negative
means reverse direction

1-9
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Block Input Output Related Information
Left wheel Force to left wheel Left wheel velocity Directional, negative
means reverse direction
Rotation Velocity difference Rotational angle Measured
between right and left counterclockwise
wheels
Coordinate Normal speed Velocity in X Not applicable
Transformation
Rotational angle Velocity in Y
Sensor X coordinate None No block necessary for

Y coordinate

modeling

Some block inputs do not exactly match block outputs. Therefore, in addition to the dynamics of the
individual components, the model must compute the following:

* Input to the rotation computation — Subtract the velocities of the two wheels and divide by two.

» Input to the coordinate transformation — Average the velocities of the two wheels.
* Input to the sensor — Integrate the outputs of the coordinate transformation.

The wheel velocities are always equal in magnitude and the computations are accurate within that

assumption.

Add the necessary components and finalize connections:

1 Add the necessary input and output ports to each subsystem. Double-click a Subsystem block.

-

In1

>

Out1

Each new Subsystem block contains one Inport (In1) and one Outport (Outl) block. These blocks
define the signal interface with the next higher level in a model hierarchy.

Each Inport block creates an input port on the Subsystem block, and each Outport block creates
an output port. The model reflects the names of these blocks as the input/output port names. Add
more blocks for additional input and output signals. On the Simulink Editor toolbar, click the

Navigate Up To Parent button | {; | to return to the top level.

For each block, add and rename Inport and Outport blocks.

_\.‘.fl fo .'_:__‘I__aﬁ force B

):: :}bg'd force [»

Right force

Inputs

LW

Forca

Speed [»

Left Wheel

L]

Forca

Speed [

Right Whesal

M Linear spead

| Angis ¥ spead

L]

Speed differenica

X epead

Coordinate Transform

Hngls B

Ratation



System Definition and Layout

When copying an Inport block to create a new one, use the Paste (Ctrl+V) option.

2  Compute required inputs to the Coordinate Transform and Rotation subsystems from the left

wheel and right wheel velocities.

Compute the Linear speed input to the Coordinate Transform subsystem. Add an Add block
from the Math Operations library and connect the outputs of the two-wheel components. Add
a Gain block and set the gain parameter to 1/2. Connect the output of the Add block to this

Gain block.

Compute the Speed difference input to the Rotation subsystem. Add a Subtract block from

the Math Operations library. Connect the right wheel velocity to the + input and the left

wheel velocity to the - input. Connect the outputs of the two wheel components. Add a Gain

block and set the gain parameter to 1/2. Connect the output of the Subtract block to this

Gain block.
3 Forca Spesad - +
- +
Laft Wheael Add
) Forca Speed
+
Right Wheel _
Subtract

Gain

3 Compute the X and Y coordinates from the X and Y velocities. Add two Integrator blocks from the

Continuous library and connect the outputs of the Coordinate Transform block. Leave initial

conditions of the Integrator blocks set to 0.

LW

LY.

Linear spead

Aumgla

X epesd

Y epead

Coordinate Transform

Integratar1

4 Complete the connections for the system.

o

_?“ fo .':J.aﬂ foroe ¥ Force Spesd
Left Whesl
)\_ _lﬁij'.l force ¥ Force Speed
Right force
Right Wheel

Inputs.

Parameters and Data

>+

r#.",,‘-

Gain

P

Subtract

,E§>——+

Speed differenca

Angle

Linzar spaad X epeed

Angla ¥ epead

-

p

rator

Inte

mj= |2 mj=

[

Gaini

Rotation

Coordinate Transform

Determine the parameters that are part of the model and their values. Use modeling goals to
determine whether these values are always fixed or change from simulation to simulation. Parameters

P

P

Integratori
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that contribute to the modeling goal require explicit representation in the model. This table helps
determine the level of detail when modeling each component.

Parameter Block Symbol Value Type

Mass Left Wheel m 2.5 kg Variable
Right Wheel

Rolling resistance |Left Wheel k drag 30 Ns?/m Variable
Right Wheel

Robot radius Rotation r 0.15m Variable

Initial angle Rotation None 0 rad Fixed

Initial velocities Left Wheel None 0 m/s Fixed
Right Wheel 0 m/s

Initial (X, Y) Integrators None (0,0)m Fixed

coordinates

Simulink uses the MATLAB workspace to evaluate parameters. Set these parameters in the MATLAB
command window:

2.5
a

rag

= 30;
.15;

S X 3
nal

See Also

Related Examples
. “Model and Validate a System” on page 1-13
. “Design a System in Simulink” on page 1-23

1-12



Model and Validate a System

Model and Validate a System

You model each component within the system structure to represent the physical or functional
behavior of that component. You verify the basic component behavior by simulating them using test
data.

Open the System Layout

A big-picture view of the whole system layout is useful when modeling individual components. Start
by loading the layout model. At the MATLAB command line, enter:

open_system('system layout.slx')

—

Lef

Right force

'-:.:-_— Left force ¥ Force Speed
. —»1/2

¥
+

h
h

Linear spaad X epead

Left Wheal

Angla ¥ speed

¥

‘Coordinate Transform
Y ) Fight force Force Speed

h

Inputs

Right Wheel
L +
»

Copyright 2018 The Math\Works, Inc.

—..@_’ Spead differerica Angle

Rotation

Model the Components

A Simulink model of a component is based on several starting points:

An explicit mathematical relationship between the output and the input of a physical component —
You can compute the outputs of the component from the inputs, directly or indirectly, through
algebraic computations and integration of differential equations. For example, computation of the
water level in a tank given the inflow rate is an explicit relationship. Each Simulink block executes
based on the definition of the computations from its inputs to its outputs.

An implicit mathematical relationship between model variables of a physical component —
Because variables are interdependent, assigning an input and an output to the component is not
straightforward. For example, the voltage at the + end of a motor connected in a circuit and the
voltage at the - end have an implicit relationship. To model such a relationship in Simulink, you
can either use physical modeling tools such as Simscape™ or model these variables as part of a
larger component that allows input/output definition. Sometimes, closer inspection of modeling
goals and component definitions helps to define input/output relationships.

Data obtained from an actual system — You have measured input/output data from the actual
component, but a fully defined mathematical relationship does not exist. Many devices have
unmodeled components that fit this description. For example, the heat dissipated by a television.
You can use the System Identification Toolbox™ to define the input/output relationship for such a
system.
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* An explicit functional definition — You define the outputs of a functional component from the
inputs through algebraic and logical computations. For example, the switching logic of a
thermostat. You can model most functional relationships as Simulink blocks and subsystems.

This tutorial models physical and functional components with explicit input/output relationships. In
this tutorial, you will:
Use the system equations to create a Simulink model.

2 Add and connect Simulink blocks in the Simulink Editor. Blocks represent coefficients and
variables from the equations.

3 Build the model for each component separately. The most effective way to build a model of a
system is to first consider components independently.

4  Start by building simple models using approximations of the system. Identify assumptions that
can affect the accuracy of your model. Iteratively add detail until the level of complexity satisfies
the modeling and accuracy requirements.

Model the Physical Components

Describe the relationships between components, for example, data, energy, and force transfer. Use
the system equations to build a graphical model of the system in Simulink.

Some questions to ask before you begin to model a component:

* What are the constants for each component? What values do not change unless you change them?
* What are the variables for each component? What values change over time?
* How many state variables does a component have?

Derive the equations for each component using scientific principles. Many system equations fall into
three categories:

» For continuous systems, differential equations describe the rate of change for variables with the
equations defined for all values of time. For example, a first-order differential equation gives the
velocity of a car:

d(\;(tt) _ %v(t) +u(t)

» For discrete systems, difference equations describe the rate of change for variables, but the
equations are defined only at specific times. For example, the control signal from a discrete
proportional-derivative controller:

pd[n] = (e[n] - e[n — 1])Kq + e[n]K,

* Equations without derivatives are algebraic equations. For example, an algebraic equation gives
the total current in a parallel circuit with two components:

L=I+1
Wheels and Linear Motion
There are two forces that act on a wheel:

» Force applied by the motor — The force F acts in the direction of velocity change and is an input
to the wheel subsystems.

1-14



Model and Validate a System

Drag force — The force Fg,,, acts against the direction of velocity change and is a function of
velocity.

Fdrag = kdragV|V|

Acceleration is proportional to the sum of these forces:

(m/2)V = F = Fraq
(m/2)V = F = kgragV|V|

7 = F - kdragvlvl
(m/2)

Where Kk, is the drag coefficient and m is the mass of the robot. Each wheel carries half of this
mass.

Build the wheel model:

1

In the system layout model, double-click the Right Wheel subsystem to display the empty
subsystem.

Model velocity and acceleration. Add an Integrator block. Leave the initial condition set to 0. The
input of this block is the acceleration Vdot and the output is the velocity V.

D gl e G

Force Spead

Model the drag force. Add a MATLAB Function block from the User-Defined Functions library.
The MATLAB Function block provides a quick way to implement mathematical expressions in
your model. To edit the function, double-click the block to open the MATLAB Function editor.

Right Wheel/Fdrag +
Ifunctin:n Fdrag = get_ fdrag(V,k drag)

- Fdrag = k_drag*V*abs (V) ;

W= L

Define arguments for the MATLAB Function block. In the MATLAB Function block editor, click

the Edit Data 14 button. Click k_drag, set Scope to Parameter, and click Apply.

Subtract the drag force from the motor force with Subtract block. Complete the force-
acceleration equation with a Gain block with parameter 1/ (m/2).

To reverse the direction of the MATLAB Function block, right-click the block and select Rotate &
Flip > Flip Block. Connect the blocks.
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o=
=
L

L 4

G r—> -
Force - 1Ami2) dot
Spesd

Fdrag 4. A

get_fdrag

Fdrag

7 The dynamics of the two wheels are the same. Make a copy of the Right Wheel subsystem you
just modeled and paste it in the Left Wheel subsystem.

8 ﬁ |

View the top level of the model. Click the Navigate Up To Parent button
Rotational Motion

When the two wheels turn in opposite directions, they move in a circle of radius r, causing rotational
motion of the robot. When the wheels turn in the same direction, there is no rotation. Assuming that
the wheel velocities are always equal in magnitude, it is practical to model rotational motion as
dependent on the difference of the two wheel velocities V; and V;:

. Vp-Vp
6= 2r

Build the rotation dynamics model:
1 In the top level of the system layout model, double-click the Rotation subsystem to display the

empty subsystem. Delete the connection between the Inport and the Outport blocks.

2 Model angular speed and angle. Add an Integrator block. Leave the initial condition set to 0. The
output of this block is the angle theta and the input is the angular speed theta dot.

3 Compute angular speed from tangential speed. Add a Gain with parameter 1/ (2*r).
Connect the blocks.

1
Speed difference .I Angle

F-

D‘||—|-

5 ﬁ |

View the top level of the model. Click the Navigate Up To Parent button
Model the Functional Components

Describe the function from the input of a function to its output. This description can include algebraic
equations and logical constructs, which you can use to build a graphical model of the system in
Simulink.

Coordinate Transformation

The velocity of the robot in the X and Y coordinates, Vx and Vy, is related to the linear speed Vy and
the angle theta:

Vx = Vycos(0)
VY = VNSil’l(H)

1-16



Model and Validate a System

Build the coordinate transformation model:

1 In the top level of the system layout model, double-click the Coordinate Transform subsystem
to display the empty subsystem.

2 Model trigonometric functions. Add a SinCos block from the Math Operations library.
Model multiplications. Add two Product blocks from the Math Operations library.
Connect the blocks.

L1 + '

kA -
Linear spead J I > v @
Y spead

=in

E -
o > ()
Angle ¥ spead

5 ﬁ |

View the top level of the model. Click the Navigate Up To Parent button
Set Model Parameters

A source for model parameter values can be:

* Written specifications such as standard property tables or manufacturer data sheets
* Direct measurements on an existing system

» Estimations using system input/output

This model uses these parameters:

Parameter Symbol Value
Mass m 2.5 kg
Rolling resistance k drag 30 Ns?/m
Robot radius r 0.15m

Simulink uses the MATLAB workspace to evaluate parameters. Set these parameters in the MATLAB
command window:

2.5
a

rag

= 30;
.15;

S X 3
N al

Validate Components Using Simulation

Validate components by supplying an input and observing the output. Even such a simple validation
can point out immediate ways to improve the model. This example validates these behaviors:

* When a force is applied continuously to a wheel, the velocity increases until it reaches a steady-
state velocity.

* When the wheels turn in opposite directions, the rotation angle increases at a constant rate.
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Validate Wheel Component

Create and run a test model for the wheel component:

1
Create a new model. In the Simulation tab, click New El—lj Copy the Right Wheel block into the
new model.

2 Create a test input. Add a Step block from the Sources library and connect it to the input of the
Right Wheel block. Leave the step time parameter set to 1.

3 Add a viewer to the output. Right-click the output port of the Right Wheel block and select
Create & Connect Viewer > Simulink > Scope.

I

¥

Force ‘Spead [

Right Wheel

4

Run the simulation. In the Simulation tab, click Run I\t"l .

F

File  Tools View Simulation Help |

@- OO Fa| &«-[Z-FE@A-

_Read:.r Sample based | T=10.000

The simulation result exhibits the general expected behavior. There is no motion until force is applied
at step time. When force is applied, the speed starts increasing and then settles at a constant when
the applied force and the drag force reach an equilibrium. In addition to validation, this simulation
also gives information on the maximum speed of the wheel for the given force.

Validate Rotation Component

Create and run a test model for the rotation model:

1
Create a new model. Click aly and copy the Rotation block into the new model.
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2 Create a test input in the new model. Add a Step block from the Sources library. Leave the step
time parameter set to 1. Connect it to the input of the Rotation block. This input represents the
difference of the wheel velocities when the wheels are rotating in opposite directions.

3 Add a viewer to the output. Right-click the output port of the Rotation block and select Create &
Connect Viewer > Simulink > Scope.

il

Y

Speed difference Angle [»

Rotation

| |
Run the simulation. In the Simulation tab, click Run \t’ .

4. Viewer: Scope — O >

File  Tools  View Simulation Help ~

@-OP® Ta q-|C- F-

Ready Sample based | T=10.000

This simulation shows that the angle increases steadily when the wheels are turning with the same
speed in opposite directions. You can make some model improvements to make it easier to interpret
the angle output, for example:

* You can convert the output in radians to degrees. Add a Gain block with a gain of 180/pi.

* You can display the degrees output in cycles of 360 degrees. Add a Math Function block with
function mod.

MATLAB trigonometric functions take inputs in radians.

Validate the Model

After you validate individual components, you can perform a similar validation on the complete
model. This example validates the following behavior:

*  When the same force is applied to both wheels in the same direction, the robot moves in a line.
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*  When the same force is applied to both wheels in opposite directions, the robot rotates in place.

1 Inthe system layout model, double-click the Inputs subsystem to display the empty
subsystem.

2 Create a test input by adding a Step block. Leave the step time parameter set to 1. Connect it to
both Outport blocks.

I >

Left force

e 2 ]

Right force

3 At the top level of the model, connect both output signals to the same scope viewer:

rspaad X epesd - % [
¥ speed » % b
rdinate Transform
4  Run the model.
4. Viewer: Scope — O >
File  Tools View Simulation Help &

-0 @ «-C-FE-

Ready Sample bazed T=10.000

In this figure, the yellow line is the X direction and the blue line is the Y direction. Since the
angle is zero and is not changing, the vehicle moves only in the X direction, as expected.
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5 Double-click the Inputs subsystem and add a Gain with parameter - 1 between the source and the
second output. This reverses the direction for the left wheel.

>
Left forca

2.

Right force

Add a scope to the angle output.
7  Run the model.

F

File Tools View Simulation Help ¥

- 0P ® e a-C-FH-

Ready Sample based | T=10.000 |
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4. Viewer: Scopel — O *

File  Tools View Simulation Help u

@-G00P® TE a-\E-+£H-

Ready Sample based T=20.000

The first view shows that there is no motion in the X-Y plane. The second view shows that there is
steady rotation.

You can use this final model to answer many questions about the model by changing the input. Some
examples are:

* What happens when the initial angle is not zero?
* How long does it take for the motion to stop when the force drops to zero?
* What happens when the robot is heavier?

* What happens when the robot moves on a smoother surface, that is, when the drag coefficient is
lower?

See Also

Related Examples
. “System Definition and Layout” on page 1-7
. “Design a System in Simulink” on page 1-23

1-22



Design a System in Simulink

Design a System in Simulink

In this section...

“Open System Model” on page 1-23
“Identify Designed Components and Design Goals” on page 1-23
“Analyze System Behavior Using Simulation” on page 1-24

“Design Components and Verify Design” on page 1-26

Model-Based Design paradigm is centered on models of physical components and systems as a basis
for design, testing, and implementation activities. This tutorial adds a designed component to an
existing system model.

Open System Model

The model is a flat robot that can move or rotate with the help of two wheels, similar to a home
vacuuming robot. Open the model by entering in the MATLAB® command line:

open_system('system model.slx")

Left force | Force _ Speed > 1|
g |- 12 fv|Linear speed X speed Ll —D‘
Left Vihieal { ! - 1
|
»!
Angia ¥ speed - —(2)
L h— Coordinate Transform
Right force | Force . ‘Spesed
Right Wheel L+
Inputs »|- Spead difference Angle
Rotation

Copyright 2018 The MathWorks, Inc.
This tutorial analyzes this system and adds functionality to it.

Identify Designed Components and Design Goals

Specification of the design objective is a critical first step to the design task. Even with a simple
system, there could be multiple and even competing design goals. Consider these goals for the
example model:

* Design a controller that varies the force input so that the wheels turn at a desired speed.

* Design inputs that make the device move in a predetermined path.

* Design a sensor and controller so that the device follows a line.

* Design a planning algorithm so that the device reaches a certain point using the shortest path
possible while avoiding obstacles.

* Design a sensor and algorithm so that the device moves over a certain area while avoiding
obstacles.

This tutorial designs an alert system. You determine the parameters for a sensor that measures the
distance from an obstacle. A perfect sensor measures the distance from an obstacle accurately. An
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alert system samples those measurements at fixed intervals so that the output is always within 0.05 m
of the measurement. The system generates an alert in time for the robot to come to a stop before
hitting the obstacle.

Analyze System Behavior Using Simulation

The design of the new component requires analyzing the linear motion of the robot to determine:

* How far the robot can travel at the top speed when power to the wheels is cut
* The top speed of the robot

Run the model with a force input that starts motion, waits until the robot reaches a steady velocity,
and then sets the input force to zero:

1 In the model, double-click the Inputs subsystem.

2 Delete the existing step input and add a Pulse Generator block.

3  Set parameters for the Pulse Generator block:

* Amplitude: 1
* Period: 20
* Pulse Width: 15
These parameters are designed to ensure that the top speed is reached. You can change
parameters to see their effect.
4 Run the model for 20 sec.

4. Viewer Scope — O >

Eile  Tools View Simulation Help o

@- 40P ® FTa w-|E-FH-

Ready Sample based T=20.000
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4. Viewer: Scopel — O ot

Eile  Tools  View Simulation Help N

@-G00P® TE a-\E-+£H-

Ready Sample based |T=20.000

The first scope shows that the speed rapidly starts decreasing when the power is cut at time 3. The
speed then asymptotically approaches zero but does not quite reach it. This is a limitation of
modeling; dynamics at low speeds without external force requires a more complex representation.
For the objective here, however, it is possible to make approximations. Zoom in on the position signal.

4 Viewer Scopel — O >

File Tools View Simulation Help u

@-4QP® Ta| w-|E-4FH-

Ready Sample based T=20.000
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At time 3, the position of the robot is at about 0.55 m. When the simulation ends, the position is less
than 0.71 m. It is safe to say that the robot travels less than 0.16 m after the power is cut.

To find the top speed:

1 Zoom on the stable region of the velocity output in time, from 1 s to 3 s.
2 Leave zoom mode by clicking the zoom button again. Click the Cursor Measurements button

&,

3  Set the second cursor to the region where the velocity curve is flat.

r

File  Tools View Simulation Help ¥

@-l40P® K@ &-|35-|F&-

M | £ ¥ Cursor Measurements

Time

1] 0.861
2! 2453

AT

Ready Sample bazed T=20.000

The Value column in the Cursor Measurements panel indicates that the top speed of the robot is
0.183 m/s. To calculate the time it takes for the robot to travel 0.05 m, divide 0.05 m by 0.183 m/s.
You get 0.27 sec.

Design Components and Verify Design

Sensor design consists of these components:
* Measurement of the distance between the robot and the obstacle — This example assumes that
the measurement is perfect.

* The time interval at which the alert system measures the distance — To keep the measurement
error below 0.05 m, this sampling interval must be less than 0.27 sec. Use 0.25 sec.

* The distance at which the sensor produces an alert — Analysis shows that slow down must start at
0.16 m from the obstacle. The actual alert distance must also take the error from discrete
measurements, 0.05 m, into account.
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Add Designed Component

Build the sensor:

Create a subsystem with the ports as shown.

[ il
) X coondinate
) ¥ coordinate

Alart [»
| Obatacke X
3 Obstacle ¥
G £

Sensor model

Construct the distance measurement subsystem. In the Sensor model block, use Subtract, Math
Function with function magnitude”2, Sum, and Sqrt blocks as shown. Note the reordering of
the input ports.

C— : =
Kcnurdinsi|—b— [ 4’@_.' Vi

)

Obstacle X

h

@O

Y Coordinate  —W - |“ |_

)

Obstacla Y

L

Model sampling. Add a Zero-Order Hold block from the Discrete library to the subsystem and set
the Sample time parameter to 0. 25.

Model the alert logic. Add a Compare to Constant block from the Logic and Bit Operations library
and set the parameters:

* Operator: <=
* Constant Value: 0.21
*  Output data type: boolean

This logical block sets its output to 1 when its input is less than or equal to 0.21.
Finish connecting the blocks.
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Verify Design
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L
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Alart

Test the design with an obstacle location of X = 0.65, Y = 0 using Constant blocks as inputs to the
Sensor model subsystem. This test verifies design functionality in the X direction. You can create
similar tests for different paths. This model only generates an alert. It does not control the robot.

1  Set the obstacle location. Add two Constant blocks from the Sources library set the constant
values to 0.65 and 0. Connect the position outputs of the robot to the inputs of the sensor.

2 Add a scope to the Alert output.

Lt Foarces ——e Frorce

Speed

Left Wheel

Right farce —{ Force

Spesd

B

12

Inputs

Right Wheel

3 Run the model.

Speed differsnce

hegle

Rotation

Linsar speed X speed

Angle ¥ speed

Coordinate Transform

065

¥ coordinale
' Coordinate
Otk X

Ohislacks ¥

Alert
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F

Eile  Tools  View Simulation Help u

@ - a® P @ - - & A

o

Ready Sample based T=20.000

4. Viewer: Scopel — O x
File  Tools View Simulation Help k]

- | BOP® K@ Q-|C | FA-

Ready Sample based T=20.000

Observe that the alert status becomes 1 once the position is within 0.21 m of the obstacle location
and the design requirement for this component is satisfied.
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For real-world systems with complex components and formal requirements, the Simulink product
family includes additional tools to refine and automate the design process. Simulink Requirements™
provide tools to formally define requirements and link them to model components. Simulink Control
Design™ can facilitate the design if you want to build a controller for this robot. Simulink Verification
and Validation™ products establish a formal framework for testing components and systems.

See Also

Related Examples

. “Model-Based Design with Simulink” on page 1-3
. “System Definition and Layout” on page 1-7
. “Model and Validate a System” on page 1-13
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2 Modeling in Simulink

Simulink Block Diagrams

Simulink is a graphical modeling and simulation environment for dynamic systems. You can create
block diagrams, where blocks represent parts of a system. A block can represent a physical

component, a small system, or a function. An input/output relationship fully characterizes a block.
Consider these examples:

A faucet fills a bucket — Water goes into the bucket at a certain flow rate, and the bucket gets
heavier. A block can represent the bucket, with flow rate as the input and its weight as the output.

You use a megaphone to make your voice heard — The sound produced at one end of the
megaphone is amplified at the other end. The megaphone is the block, the input is the sound wave
at its source, and the output is the sound wave as you hear it.

You push a cart and it moves — The cart is the block, the force you apply is the input, and the
cart's position is the output.

The definition of a block is only complete with its inputs and outputs defined; this task relates to the

goal of the model. For example, the cart velocity may be a natural choice as an output if the modeling
goal does not involve its location.

Simulink provides block libraries that are collections of blocks grouped by functionality. For example,

to model a megaphone that multiplies its input by a constant, you use a Gain block from the Math
Operations library.

>

A sound wave goes into the megaphone as its input, and a louder version of the same wave comes out
as its output.

The > signs denote the inputs and outputs of a block, which can be connected to other blocks.

You can connect blocks to other blocks to form systems and represent more complex functionality. For
example, an audio player turns a digital file into sound. A digital representation is read from storage,
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is interpreted mathematically, and then turned into physical sound. The software that processes the
digital file to compute the sound waveform can be one block; the speaker that takes the waveform
and turns it into sound can be another block. A component that generates the input is another block.

To model the sine wave input to the megaphone in Simulink, include a Sine Wave source.
s
\J >

The primary function of Simulink is to simulate behavior of system components over time. In its

simplest form, this task involves keeping a clock, determining the order in which the blocks are to be
simulated, and propagating the outputs computed in the block diagram to the next block. Consider

the megaphone. At each time step, Simulink must compute the value of the sine wave, propagate it to
the megaphone, and then compute the value of its output.

KH:'\'

L

Simulink Clock
i=1

"x >b> |"|

tim'e
[
|

\

t=1

1]
-

At each time step, each block computes its outputs from its inputs. Once all of the signals in a
diagram are computed at a given time step, Simulink determines the next time step (based on the
model configuration and numerical solver algorithms) and advances the simulation clock. Then each
block computes their output for this new time step.
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In simulation, time progresses differently from a real clock. Each time step takes as much time as it
takes to finish the computations for that time step, whether that time step represents a fraction of a

second or a few years.

Often, the effect of a component's input on its output is not instantaneous. For example, turning on a
heater does not result in an instant change in temperature. Rather, this action provides input to a
differential equation. The history of the temperature (a state) is also a factor. When simulation
requires solving a differential or difference equation, Simulink employs memory and numerical
solvers to compute the state values for the time step.

Simulink handles data in three categories:

* Signals — Block inputs and outputs, computed during simulation

* States — Internal values, representing the dynamics of the block, computed during simulation

» Parameters — Values that affect the behavior of a block, controlled by the user

At each time step, Simulink computes new values for signals and states. By contrast, you specify
parameters when you build the model and can occasionally change them while simulation is running.

See Also

Related Examples
. “Create a Simple Model” on page 3-2
. “Model-Based Design with Simulink” on page 1-3



Simple Simulink Model
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Create a Simple Model

3-2

In this section...

“Open New Model” on page 3-3

“Open Simulink Library Browser” on page 3-5
“Add Blocks to a Model” on page 3-7
“Connect Blocks” on page 3-7

“Add Signal Viewer” on page 3-8

“Run Simulation” on page 3-8

“Refine Model” on page 3-9

You can use Simulink to model a system and then simulate the dynamic behavior of that system. The
basic techniques you use to create a simple model in this tutorial are the same as those you use for
more complex models. This example simulates simplified motion of a car. A car is typically in motion
while the gas pedal is pressed. After the pedal is released, the car idles and comes to a stop.

A Simulink block is a model element that defines a mathematical relationship between its input and
output. To create this simple model, you need four Simulink blocks.

Block Name Block Purpose Model Purpose
Pulse Generator Generate an input signal for the |Represent the accelerator pedal
model
Gain Multiply the input signal by a Calculate how pressing the
constant value accelerator affects the car
acceleration
Integrator, Second-Order Integrate the input signal twice |Obtain position from
acceleration
Outport Designate a signal as an output |Designate the position as an
from the model output from the model
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e N et B0 v|<1£ & > =
Step

E Save - - |Norma|
Library _Log Run Step  Siop Data
~ (= Print * Browser signals @ Fast Restart Back ™ - Forward Inspector
FILE |L|BHARY | FREPARE | SIMULATE | REVIEW RESULTS | a
Tools,
moving_car
® moving_car -
= m 0 . »(D)
Tl |24 (2
x D!
D Copyright 2017-2018 The MathWaorks, Inc.
Ready 100% VariableStepAuto

Simulating this model integrates a brief pulse twice to get a ramp. The results display in a Scope
window. The input pulse represents a press of the gas pedal — 1 when the pedal is pressed and 0
when it is not. The output ramp is the increasing distance from the starting point.

Open New Model

Use the Simulink Editor to build your models.

Start MATLAB. From the MATLAB toolstrip, click the Simulink button L:iJ
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b. Simulink Start Page

Examples
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2 Click the Blank Model template.

The Simulink Editor opens.
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3 From the Simulation tab, select Save > Save as. In the File name text box, enter a name for
your model. For example, simple model. Click Save. The model is saved with the file

extension .s1x.

Open Simulink Library Browser

Simulink provides a set of block libraries, organized by functionality in the Library Browser. The
following libraries are common to most workflows:

* Continuous — Blocks for systems with continuous states

* Discrete — Blocks for systems with discrete states

* Math Operations — Blocks that implement algebraic and logical equations

* Sinks — Blocks that store and show the signals that connect to them

* Sources — Blocks that generate the signal values that drive the model

From the Simulation tab, click the Library Browser button g3.
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S8 Simulink Library Browser — O X
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2 Set the Library Browser to stay on top of the other desktop windows. On the Simulink Library
Browser toolbar, select the Stay on top button |

To browse through the block libraries, select a category and then a functional area in the left pane. To
search all of the available block libraries, enter a search term.

For example, find the Pulse Generator block. In the search box on the browser toolbar, enter pulse,
and then press Enter. Simulink searches the libraries for blocks with pulse in their name or
description and then displays the blocks.

SE Simulink Library Browser — O >

‘Q:' |pu|se Vl"ne*' :E‘j]v'jv = @

Search Results: pulse
<< >> Page 1 of 2 (126 Blocks found)
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Continuous
Signal Routing Pulse Generator
Sinks
Sources
String " n :.! ]
2 3 ok ek b "
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Get detailed information about a block. Right-click the Pulse Generator block, and then select Help
for the Pulse Generator block. The Help browser opens with the reference page for the block.

Blocks typically have several parameters. You can access all block parameters by double-clicking the
block.

Add Blocks to a Model

To start building the model, browse the library and add the blocks.

1 From the Sources library, drag the Pulse Generator block to the Simulink Editor. A copy of the
Pulse Generator block appears in your model with a text box for the value of the Amplitude
parameter. Enter 1.

M

Parameter values are held throughout the simulation.
2 Add the following blocks to your model using the same approach.

Block Library Parameter

Gain Simulink/Math Operations Gain: 2
Integrator, Second- Simulink/Continuous Initial condition: @
Order

Outport Simulink/Sinks Port number: 1

Add a second Outport block by copying the existing one and pasting it at another point using
keyboard shortcuts.

Your model now has the blocks you need.
3 Arrange the blocks by clicking and dragging each block. To resize a block, drag a corner.

] b )[>> b

=
b

[

fal =
o
=
b

Connect Blocks
Connect the blocks by creating lines between output ports and input ports.
1  Click the output port on the right side of the Pulse Generator block.

The output port and all input ports suitable for a connection are indicated by a blue chevron
symbol >.

. »)D) ’”:_20::
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Point to ) to see the connection cue.

s> 3 2.

Click the cue. Simulink connects the blocks with a line and an arrow indicating the direction of
signal flow.

1 xp
M—rb> F Zab

3 Connect the output port of the Gain block to the input port on the Integrator, Second-Order
block.

Connect the two outputs of the Integrator, Second-Order block to the two Outport blocks.
5 Save your model. In the Simulation tab, click Save.

-
NS
UL Z wf—>(2)

Add Signal Viewer

To view simulation results, connect the first output to a Signal Viewer.

Click the signal. In the Simulation tab under Prepare, click Add Viewer. Select Scope. A viewer
icon appears on the signal and a scope window opens.

L,
| —Fb—’u iz
o ——p( 2 )

You can open the scope at any time by double-clicking the icon.

Run Simulation

After you define the configuration parameters, you are ready to simulate your model.

1 In the Simulation tab, set the simulation stop time by changing the value in the toolbar.

SIMULATIOMN
3 Open =~ [ Stop Time | 10.0 —_—
= = & d @ b 2
ave - - o - N _ -
New Library LT Step Run Step Data
* = Print - Browser m@ Fast Restart Back = - Forward Inspector
FILE LIERARY PREPARE SIMULATE REVIEW RESULTS

The default stop time of 10. 0 is appropriate for this model. This time value has no unit. The time
unit in Simulink depends on how the equations are constructed. This example simulates the
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simplified motion of a car for 10 seconds — other models could have time units in milliseconds or
years.

To run the simulation, click the Run button ® .

The simulation runs and produces the output in the viewer.

4 Viewer: Scope — O et

File Teools  View  Simulation  Help o

- GOP® T |- -|C-|4F&-

Ready Sample bazed T=10.000

Refine Model

This example takes an existing model, moving car.slx, and models a proximity sensor based on
this motion model. In this scenario, a digital sensor measures the distance between the car and an
obstacle 10 m (30 ft) away. The model outputs the sensor measurement and the position of the car,
taking these conditions into consideration:

* The car comes to a hard stop when it reaches the obstacle.

* In the physical world, a sensor measures the distance imprecisely, causing random numerical
errors.

* A digital sensor operates at fixed time intervals.
Change Block Parameters

To start, open the moving car model. At the MATLAB command line, enter:

open_system('moving car.slx")
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You first need to model the hard stop when the car position reaches 10 . The Integrator, Second-
Order block has a parameter for that purpose.

Double-click the Integrator, Second-Order block. The Block Parameters dialog box appears.

2 Select Limit x and enter 10 for Upper limit x. The background color for the parameter changes
to indicate a modification that is not applied to the model. Click OK to apply the changes and
close the dialog box.

Add New Blocks and Connections

Add a sensor that measures the distance from the obstacle.

1 Modify the model. Expand the model window to accommodate the new blocks as necessary.

Find the actual distance. To find the distance between the obstacle position and the vehicle
position, add the Subtract block from the Math Operations library. Also add the Constant
block from the Sources library to set the constant value of 10 for the position of the obstacle.

Model the imperfect measurement that would be typical to a real sensor. Generate noise by
using the Band-Limited White Noise block from the Sources library. Set the Noise power
parameter to 0.001. Add the noise to the measurement by using an Add block from the Math
Operations library.

Model a digital sensor that fires every 0.1 seconds. In Simulink, sampling of a signal at a
given interval requires a sample and hold. Add the Zero-Order Hold block from the Discrete
library. After you add the block to the model, change the Sample Time parameter to 0. 1.

Add another Outport to connect to the sensor output. Keep the default value of the Port
number parameter.

2  Connect the new blocks. The output of the Integrator, Second-Order block is already connected
to another port. To create a branch in that signal, left-click the signal to highlight potential ports
for connection, and click the appropriate port.
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Create a Simple Model

Annotate Signals

Add signal names to the model.

1

2
3

Double-click the signal and type the signal name.

To finish, click away from the text box.

Repeat these steps to add the names as shown.

i

= attual distance

I
x - L
u1— I position '{D
padal pasition atceleration 22 dx =( > }

Compare Multiple Signals

Compare the actual distance signal with the measured distance signal.

1

e+
10 > o [H
" L L
L maasured dislance

J

Create and connect a Scope Viewer to the actual distance signal. Right-click the signal and
select Create & Connect Viewer > Simulink > Scope. The name of the signal appears in the

viewer title.
Add the measured distance signal to the same viewer. Right-click the signal and select

Connect to Viewer > Scopel. Make sure that you are connecting to the viewer you created in

the previous step.
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& Cut Carl+X

4 Copy Cirl+C

[ Paste Cirl+V
Delete Del

Highleght Signal to Source
Highlaght Signal to Destination

Remove Highlighting Cirl+ Shift+H

Format *

Add Conditional Breakpont

Show Value Label of Selecied Port
= Log Selected Signals

ﬁ:gl:.ﬂ & Scope En":.'.g-:,"

Create & Connect Viewer '
Connect To Viewer L] Scope
Scopel
L 2
Lin&ar -ﬂ.!".'l|!,-'§l'._Pl.\'ll'.':- b

Signal Hierarchy
Propertes

3  Run the model. The Viewer shows the two signals, actual distance in yellow and measured
distance in blue.

4. Viewer: Scopel (actual distance, measu... — O X

File Tools View Simulation Help o

-0 S| &-[(E-F -

Ready Sample based |T=10.000
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Create a Simple Model

u .

Zoom into the graph to observe the effect of noise and sampling. Click the Zoom button
Left-click and drag a window around the region you want to see more closely.

4. Viewer Scopel (actual distance, measu... - O X

File Tools View Simulation Help &
G- B0Pe @ Q- K- FA-

actual distance, measured distance

Ready Sample based | T=10.000

You can repeatedly zoom in to observe the details.

4. Viewer: Scopel (actual distance, measu... — O X
File Tools View Simulation Help o
o -| 4 (_;_) I (& -F-é, TR E:EI - | 4 L -

actual distance, measured distance

Ready Sample based |T=10.000
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3 Simple Simulink Model

From the plot, note that the measurement can deviate from the actual value by as much as 0.3 m.
This information becomes useful when designing a safety feature, for example, a collision warning.

See Also
Blocks

Add | Band-Limited White Noise | Constant | Gain | Pulse Generator | Second-Order Integrator | Zero-
Order Hold

Related Examples
. “Model and Validate a System” on page 1-13
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4 Navigate a Simulink Model

Navigate Model

In this section...

“Navigate Through Model Hierarchy” on page 4-2
“View Signal Attributes” on page 4-4

“Trace a Signal” on page 4-6

Simulink models can be organized into hierarchical components. In a hierarchical model, you can
choose to view the system at a high level, or navigate down the model hierarchy to see increasing
levels of model detail.

Navigate Through Model Hierarchy
To start, open the smart braking model. At the MATLAB® command line, enter:

open_system('smart braking.slx")

4-2

Obstacle location
| Gas pedal | Prootirity L - | Prcimity 1 1 L .‘r@
Gas padal vehicle position F— | Vahicle location proximity
| Brake padal distance traveled
Procimity sensor
Vehicle ¥ Alert system

Copyright 2018 The MathWiorks, Inc.

In the model:

» A vehicle moves as the gas pedal is pressed.

* A proximity sensor measures the distance between the vehicle and an obstacle.
* An alert system generates an alarm based on that proximity.

* The alarm automatically controls the brake to prevent a collision.

When you build a model, you connect blocks together to model complex components that represent
system dynamics. In this model, Vehicle, Proximity sensor, and Alert system are all complex
components with multiple blocks that exist in a hierarchy of subsystems. To view the contents of a
subsystem, double-click the subsystem.

To view a representation of the complete model hierarchy, click the Hide/Show Model Browser
button at the bottom left corner of the model window.




Navigate Model

Model Browser E ¥ X smart_braking
i smart_braking ® < P& smart_braking
? E Alert system
> E Proximity sensor Q
> [Pal venicle
E3
=
! Gae pedal
[
[
« | ¢
Ready | Hide/Show Model Browser i

The Model Browser shows that all subsystems you view at the top level have subsystems of their own.
Expand each subsystem node to see the subsystems it contains. You can navigate through the
hierarchy in the Model Browser. For example, expand the Proximity sensor node and then select the

Sensor model subsystem.

P X

| Model Browser -

v smart_braking

v Alert system
Alert device
Alert logic

b Proximity sensor
Sensor model
Signal conditioning

v [Pal vehicle
Brake system
Engine
Vehicle Dynamics

OB @ 4 B8

Sensor model

®

L=}
|

=

#

L= i smarr._l:lraking b PFD}{iI'I'Iit'p’ sensor F Smsur model

distance from obstacle

e

b J

>

proximity sensor output
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4 Navigate a Simulink Model

The address bar shows which subsystem you are viewing. To open the subsystem in a separate
window, right-click the subsystem and select Open In New Window.

Every input or output port on a subsystem has a corresponding Inport or Outport block inside the
subsystem. These blocks represent data transfer between a subsystem and its parent. When a system
contains multiple input or output ports, the number on the Inport or Outport blocks indicates the
position of the port on the subsystem interface.

View Signal Attributes

Signal lines in Simulink indicate data transfer from block to block. Signals have properties

corresponding to their function in the model:

* Dimensions — Scalar, vector, or matrix

» Data type — String, double, unsigned integer, etc.

* Sample time — A fixed time interval at which the signal has an updated value, or continuous
sampling

To show the data type of all signals in a model, in the Debug tab, under Information Overlays, click
Base Data Types.

double

10

dauble P Obstacle location | double || uint8
1 P Gas pedal double Proximity — - Prosimity Output > 1)
Gas padal ! vehicle position B Wehicle location proximily
| Brake pedal distance lravalad
Proximity sensor
Vehicle Alert system

The model displays data types along the signal lines. Most signals are double, except the output of
the Alert system. Double-click the subsystem to investigate.

doubla double uintg
1) I Proximiby Alert index e Alart index  Absrt output 1)
Proximity

Alert device

Alart logic

The data type labels in this subsystem show that data type change occurs in the Alert device
subsystem. Double-click the subsystem to investigate.

doubl intg
O™ ume »CD)

Alert index ~ Alert output

The Alert device component converts the Alert index signal from a double to an integer. You can
set the data type at sources, or use a Data Type Conversion block from the Signal Attributes library.
Double, the default data type, provides the best numerical precision and is supported in all blocks.
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The double data type also uses the most memory and computing power. Other numerical data types
can be used to model embedded systems where memory and computing power are limited.

To show sample times, in the Debug tab, under Information Overlays, click Colors from the
Sample Time section. The model updates to show different colors for each sample time in the model,
along with a legend.

L L double uintd
g ||| double Promimaty L - Proximity Ouiput .';{I)
wehicla position ‘Wehicke location proGdEmity
- Brake padal distance travelad
Alert systam
Timing Legend 7 I
Highlight | Mone '||||"P

¥ Continuous

Continuous

“ Discrete Period
[ ] 0.1

v Other
- Constant
[: Multirate

* A block or signal with continuous dynamics is black. Signals with continuous sample time update
as often as Simulink requires to make the computations as close to the physical world as possible.

* A block or signal that is constant is magenta. They remain unchanged through simulation.

» A discrete block or signal that updates at the lowest fixed interval is red. Signals with discrete
sample time update at a fixed interval. If the model contains components with different fixed
sample times, each discrete sample time has a different color.

* Multirate subsystems, which contain a mix of discrete and continuous signals, are yellow.
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4-6

Trace a Signal
This model has a constant input and a discrete output. To determine where the sampling scheme

changes, trace the output signal through blocks.

1
p
To open the Model Browser, click the Hide/Show Model Browser button
2 To highlight the output signal, select the signal and, in the Signal tab, click the Trace to Source

button .

The editor is now in highlight mode. Click the editor to continue.

4 Keep tracing the signal to its source until you reach the Alert logic subsystem. You see that the
Subtract block has two inputs. Choose the signal path from the Inport by pressing the down
arrow key.

5 To find the source of the discretization, keep pressing the left arrow and note the colors of port
names that reflect the sample time.
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The Zero-Order Hold block in the Sensor model subsystem coverts the signal from continuous to
discrete.

See Also

Related Examples

. “Create a Simple Model” on page 3-2
. “Model-Based Design with Simulink” on page 1-3
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